Financial Engineering
Financial Engineering
Module Introduction and Overview

Contents

  1  Introduction to the Module                   2
  2  The Module Authors                          2
  3  Study Materials                             3
  4  Module Overview                             5
  5  Learning Outcomes                           8
  6  Assessment                                  8
  Specimen Examination                         15
1 Introduction to the Module

Welcome to this module on Financial Engineering. The module provides an introduction to the analysis of derivatives in financial markets. You will learn the main features of the most commonly used financial derivatives, and you will understand how to use them for the management of risk.

These units explain and discuss the theoretical models that are used to analyse derivatives, and you will also see how derivatives are used in practice. You will study spreadsheet models of derivatives, analysing the performance and valuation of derivatives contracts and trading strategies, starting with the simplest options, and extending to more complex strategies and derivatives contracts. These spreadsheet models will help you to develop a deeper and stronger understanding of derivatives and how they work.

This module focuses on the conceptual and analytical aspects of derivatives. After studying this module, you will be able to understand the main characteristics of derivatives, the potential for using derivatives to manage risk, and you should be able to avoid some of the more serious misunderstandings and mistakes associated with using derivatives. The module is not a substitute for the professional expertise that can only be acquired by directly working in financial markets. But you will find that a solid grounding in the principles of derivatives will enable you to understand much better the practical aspects of derivatives investment and risk management.

The module is concerned with financial engineering as the application of statistical and mathematical methods to analyse and use derivatives in financial markets. The term ‘financial engineering’ also refers to the manipulation of the capital structure of a company to attempt to increase shareholder value. Financial engineering in relation to capital structure is studied in the CeFiMS modules Corporate Finance and Introduction to Valuation.

2 The Module Authors

Professor Scaramozzino has taught Risk Management for the on-campus MSc in Finance and Financial Law in London and has contributed to several off-campus CeFiMS modules, including Mathematics and Statistics for Economists, Portfolio Analysis and Derivatives, Quantitative Methods for Financial Management, Managerial Economics and Risk Management: Principles and Applications.

Jonathan Simms is a tutor for CeFiMS, and has taught at Manchester Business School, University of Manchester, University of Durham and University of London. Dr Simms has contributed to development of various CeFiMS modules including Risk Management: Principles and Applications, Econometric Principles and Data Analysis, Econometric Analysis and Applications, Financial Econometrics, Introduction to Valuation, Advanced Topics in Valuation, Public Financial Management: Reporting and Audit, Banking Strategy, Corporate and Investment Banking, and Introduction to Law and to Finance.

3 Study Materials

This study guide is your main learning resource for the module, and it directs you through the eight study units. In the units you will be asked to work through and use spreadsheet models, and to answer questions and solve exercises relating to the module materials. The review questions and exercises are an essential part of the module, and it is important that you take your time to answer them. Answers to the review questions are provided within the units, and solutions to the exercises are provided at the end of each unit.

Each unit also has recommended reading from two textbooks.

📖 Textbooks

The first reference for this module is a textbook by John Hull:


This is a classic textbook on derivatives. It is written by an authority in the field, and covers both theoretical and practical aspects in the use of derivatives. It discusses all the most commonly used derivative instruments, and contains a large number of examples and exercises. This textbook also explains a number of significant events and analyses relevant case studies in financial markets.

The textbook itself is very thorough. In this module you will not study the book by Hull in its entirety, but will instead concentrate on a selected number of key chapters. If you have a professional interest in derivatives and financial engineering, however, you will find it extremely useful to study all the remaining chapters as well.

The second reference is a textbook by Simon Benninga:
This textbook explains and demonstrates how to implement financial models in Excel. It includes very useful worked examples and applications. The practical ‘how to’ approach favoured by Benninga works well with the more theoretical approach you will find in your Hull textbook, and the Excel workbooks will develop and reinforce your understanding of the theoretical material.

The Benninga textbook applies financial modelling in Excel for a range of topics also including corporate finance, valuation, and portfolio models. In this module you will focus on the sections of the book relating to options, bonds, and Monte Carlo simulations.

Software

The textbook by Hull comes with an access code for the proprietary software DerivaGem. This software enables you to compute the prices of a large number of derivatives and to draw the relevant graphs. You should familiarise yourself with DerivaGem, and you will make extensive use of it as you study the textbook and the module units.

Please now install the DerivaGem software on your PC. You may wish to refer to the appendix on DerivaGem Software on pages 862–66 of the textbook by Hull for a general description of the software, although for the moment all you will need are the general instructions on page 862.

The publication by Benninga comes with Excel workbooks that implement the models covered in the Financial Modeling textbook. These Excel workbooks demonstrate the theoretical models that you will study in the units and in the Hull textbook.

Each unit includes one or two application sections that will guide you through the structure and operation of the relevant spreadsheet models and Excel workbooks. The Excel workbooks studied in the module will be available in your module study area on the VLE.

The application sections build very gently and steadily as you progress through the module, starting with the construction of profit patterns for simple options, through to more complex option strategies, simulating asset price paths, option valuation, dynamic hedging, trading volatility, computing default-adjusted expected bond returns, constructing binomial trees, and using simulation and Monte Carlo techniques to value more complex, exotic options.

As you work through the units you will also strengthen your understanding of the related spreadsheet techniques, including data tables and sensitivity analysis, array operations, macros and VBA routines (Visual Basic for Applications). Appropriate guidance and assistance is provided in the units.
4 Module Overview

Unit 1 Derivatives Contracts
  1.1 Introduction
  1.2 Forward Contracts
  1.3 Futures Contracts
  1.4 Options
  1.5 Types of Traders
  1.6 A ‘Health Warning’
  1.7 Application: Data tables
  1.8 Conclusion
  1.9 Solutions to Exercises

Unit 2 Properties of Stock Options
  2.1 Introduction
  2.2 Options
  2.3 Stock Options
  2.4 Warrants, Employee Stock Options and Convertibles
  2.5 Basics of Pricing Stock Options
  2.6 Trading Strategies Involving Options
  2.7 Application: Profit Patterns for Options and Option Strategies
  2.8 Conclusion
  2.9 Solutions to Exercises

Unit 3 The Behaviour of the Stock Price and the Black–Scholes–Merton Model
  3.1 Introduction
  3.2 The Wiener Process
  3.3 The Behaviour of Stock Prices
  3.4 Itô’s Lemma
  3.5 The Lognormal Property of Stock Prices
  3.6 The Black–Scholes–Merton Equation and the Black–Scholes–Merton Formula
  3.7 Application 1: Simulating a lognormal process
  3.8 Application 2: Black–Scholes–Merton option pricing
  3.9 Conclusion
  3.10 Solutions to Exercises

Unit 4 Greek Letters and Trading Strategies
  4.1 Introduction
  4.2 Naked and Covered Positions
  4.3 Delta $\Delta$ Hedging
  4.4 Theta $\Theta$
  4.5 Gamma $\Gamma$
  4.6 Vega $\nu$
  4.7 Rho $\rho$
  4.8 Hedging and Portfolio Insurance
  4.9 Application 1: Delta Hedging a Call
  4.10 Application 2: VBA Code for Option Pricing and the Greeks
  4.11 Conclusion
  4.12 Solutions to Exercises
# Unit 5  Interest Rate Models

5.1 Introduction  
5.2 Implied Volatility  
5.3 Volatility Smiles  
5.4 Trading Volatility  
5.5 Application 1: Computing implied volatility  
5.6 Application 2: Options strategies  
5.7 Conclusion  
5.8 Solutions to Exercises

# Unit 6  Credit Derivatives and Credit Risk

6.1 Introduction  
6.2 Credit Ratings and Default Probabilities  
6.3 Mitigation of Credit Risk and Default Correlation  
6.4 Credit Default Swaps  
6.5 Asset-Backed Securities and Collateralised Debt Obligations  
6.6 Correlation and the Gaussian Copula  
6.7 Application: Calculating Default-adjusted Expected Bond Returns  
6.8 Conclusion  
6.9 Solutions to Exercises

# Unit 7  Some Exotic Options

7.1 Introduction  
7.2 Binomial Trees  
7.3 Alternative Procedures for Constructing Trees  
7.4 Monte Carlo Simulations  
7.5 Finite Difference Methods  
7.6 Alternatives to Black–Scholes–Merton  
7.7 Stochastic Volatility Models  
7.8 American Options  
7.9 Application 1: Binomial Trees  
7.10 Application 2: Pricing a Simple Call Option Using Monte Carlo Methods  
7.11 Conclusion  
7.12 Solutions to Exercises

# Unit 8  Further Numerical Procedures

8.1 Introduction  
8.2 Exotic Options  
8.3 Barrier, Binary and Lookback Options  
8.4 Asian Options  
8.5 Some Other Exotic Options  
8.6 Weather and Energy Derivatives  
8.7 Insurance Derivatives  
8.8 Application 1: Asian Options  
8.9 Application 2: Barrier Options  
8.10 Conclusion  
8.11 Solutions to Exercises
This module presents some of the main types of derivatives, how they are used, and how to analyse them.

**Unit 1** introduces the basic derivatives contracts – *i.e.* forwards, futures and options. The application section introduces data tables, a tool widely used for sensitivity analysis, and constructs the profit pattern for a simple call option.

**Unit 2** discusses in more detail the properties of stock options, which are among the most commonly traded derivative contracts. The unit develops a deeper understanding of how options work and how they can be used to manage risk. In the application section you will construct the profit patterns for a number of trading strategies involving call and put options.

**Unit 3** examines some of the stochastic processes that are widely applied in finance. To value an option we need to model how the price of the underlying asset varies over time. So we need to understand the stochastic process that we believe drives the asset price. In the application sections you will use a spreadsheet model to simulate stock price paths based on one particular stochastic process, the lognormal distribution, and price options using the Black–Scholes–Merton option pricing formulas.

**Unit 4** discusses how you can measure the sensitivity of a derivative portfolio to its risk factors, and explains how you can effectively reduce the risk of your position. You will analyse a delta hedging strategy in Excel. You will also study how to formulate user-defined spreadsheet functions to calculate option prices and the option ‘Greeks’.

**Unit 5** is concerned with volatility. The unit considers how to compute the volatility of asset returns implied by the market prices of options. It examines the relationship between implied volatility and the strike price of options, known as a ‘volatility smile’. The unit explains how options can be characterised by their option delta, and priced in terms of their volatility. The unit also examines options strategies for trading volatility, for hedging and speculation.

**Unit 6** examines the concept of credit risk and introduces credit derivatives. It considers how risk is rated, and discusses a number of investment vehicles for transferring credit risk, including ‘single-name’ derivatives like credit default swaps, and ‘multi-name’ derivatives like asset-backed securities and collateralised debt obligations. The unit assesses the methods for computing correlation of possible default between securities. You will also consider a spreadsheet model of default-adjusted expected bond returns, incorporating credit rating, probability of default, migration of credit rating, and partial recovery.

**Unit 7** introduces some of the more advanced numerical procedures that are necessary to analyse complex options. The unit also considers alternatives to the Black–Scholes–Merton model. The application sections construct binomial trees in Excel, and demonstrate how Monte Carlo methods can be used to value an option. This approach involves simulating the price path of the underlying asset.
Unit 8 examines options that have more complex, non-standard features, known as exotic options. The value of some of these more complex options depends not only on the price of the underlying asset at the maturity of the option, but also on the price of the asset during the life of the option. You will see how to value this type of option using the Monte Carlo approach.

5 Learning Outcomes

When you have completed your study of this module, you will be able to:

- analyse advanced derivative trading strategies for hedging and speculation
- understand the Black–Scholes–Merton model and its applications
- calculate delta and other measures of sensitivity
- discuss volatility, and strategies for trading volatility
- assess the role of credit derivatives in risk management
- apply advanced numerical techniques for valuing complex options
- construct and use spreadsheet models to analyse derivatives.

6 Assessment

Your performance on each module is assessed through two written assignments and one examination. The assignments are written after Unit 4 and Unit 8 of the module session. Please see the VLE for submission deadlines. The examination is taken at a local examination centre in September/October.

Preparing for assignments and exams

There is good advice on preparing for assignments and exams and writing them in Chapter 8 of Studying at a Distance by Christine Talbot. We recommend that you follow this advice.

The examinations you will sit are designed to evaluate your knowledge and skills in the subjects you have studied: they are not designed to trick you. If you have studied the module thoroughly, you will pass the exam.

Understanding assessment questions

Examination and assignment questions are set to test your knowledge and skills. Sometimes a question will contain more than one part, each part testing a different aspect of your skills and knowledge. You need to spot the key words to know what is being asked of you. Here we categorise the types of things that are asked for in assignments and exams, and the words used. All the examples are from the Centre for Financial and Management Studies examination papers and assignment questions.
Definitions
Some questions mainly require you to show that you have learned some concepts, by setting out their precise meanings. Such questions are likely to be preliminary and be supplemented by more analytical questions. Generally, ‘Pass marks’ are awarded if the answer only contains definitions. They will contain words such as:

- Describe
- Define
- Examine
- Distinguish between
- Compare

- Contrast
- Write notes on
- Outline
- What is meant by
- List

Reasoning
Other questions are designed to test your reasoning, by explaining cause and effect. Convincing explanations generally carry additional marks to basic definitions. They will include words such as:

- Interpret
- Explain
- What conditions influence
- What are the consequences of
- What are the implications of

Judgement
Others ask you to make a judgement, perhaps of a policy or of a course of action. They will include words like:

- Evaluate
- Critically examine
- Assess
- Do you agree that
- To what extent does

Calculation
Sometimes, you are asked to make a calculation, using a specified technique, where the question begins:

- Use indifference curve analysis to
- Using any economic model you know
- Calculate the standard deviation
- Test whether

It is most likely that questions that ask you to make a calculation will also ask for an application of the result, or an interpretation.

Advice
Other questions ask you to provide advice in a particular situation. This applies to law questions and to policy papers where advice is asked in relation to a policy problem. Your advice should be based on relevant law, principles and evidence of what actions are likely to be effective. The questions may begin:

- Advise
- Provide advice on
- Explain how you would advise

**Critique**

In many cases the question will include the word ‘critically’. This means that you are expected to look at the question from at least two points of view, offering a critique of each view and your judgement. You are expected to be critical of what you have read.

The questions may begin:
- Critically analyse
- Critically consider
- Critically assess
- Critically discuss the argument that

**Examine by argument**

Questions that begin with ‘discuss’ are similar – they ask you to examine by argument, to debate and give reasons for and against a variety of options, for example

- Discuss the advantages and disadvantages of
- Discuss this statement
- Discuss the view that
- Discuss the arguments and debates concerning

---

**The grading scheme: Assignments**

The assignment questions contain fairly detailed guidance about what is required. All assignments are marked using marking guidelines. When you receive your grade it is accompanied by comments on your paper, including advice about how you might improve, and any clarifications about matters you may not have understood. These comments are designed to help you master the subject and to improve your skills as you progress through your programme.

**Postgraduate assignment marking criteria**

The marking criteria for your programme draws upon these minimum core criteria, which are applicable to the assessment of all assignments:

- understanding of the subject
- utilisation of proper academic [or other] style (e.g. citation of references, or use of proper legal style for court reports, etc.)
- relevance of material selected and of the arguments proposed
- planning and organisation
- logical coherence
- critical evaluation
- comprehensiveness of research
- evidence of synthesis
- innovation/creativity/originality.

The language used must be of a sufficient standard to permit assessment of these.
The guidelines below reflect the standards of work expected at postgraduate level. All assessed work is marked by your Tutor or a member of academic staff, and a sample is then moderated by another member of academic staff. Any assignment may be made available to the external examiner(s).

80+ (Distinction). A mark of 80+ will fulfil the following criteria:
- very significant ability to plan, organise and execute independently a research project or coursework assignment
- very significant ability to evaluate literature and theory critically and make informed judgements
- very high levels of creativity, originality and independence of thought
- very significant ability to evaluate critically existing methodologies and suggest new approaches to current research or professional practice
- very significant ability to analyse data critically
- outstanding levels of accuracy, technical competence, organisation, expression.

70–79 (Distinction). A mark in the range 70–79 will fulfil the following criteria:
- significant ability to plan, organise and execute independently a research project or coursework assignment
- clear evidence of wide and relevant reading, referencing and an engagement with the conceptual issues
- capacity to develop a sophisticated and intelligent argument
- rigorous use and a sophisticated understanding of relevant source materials, balancing appropriately between factual detail and key theoretical issues. Materials are evaluated directly and their assumptions and arguments challenged and/or appraised
- correct referencing
- significant ability to analyse data critically
- original thinking and a willingness to take risks.

60–69 (Merit). A mark in the 60–69 range will fulfil the following criteria:
- ability to plan, organise and execute independently a research project or coursework assignment
- strong evidence of critical insight and thinking
- a detailed understanding of the major factual and/or theoretical issues and directly engages with the relevant literature on the topic
- clear evidence of planning and appropriate choice of sources and methodology with correct referencing
- ability to analyse data critically
- capacity to develop a focussed and clear argument and articulate clearly and convincingly a sustained train of logical thought.

50–59 (Pass). A mark in the range 50–59 will fulfil the following criteria:
- ability to plan, organise and execute a research project or coursework assignment
- a reasonable understanding of the major factual and/or theoretical issues involved
• evidence of some knowledge of the literature with correct referencing
• ability to analyse data
• examples of a clear train of thought or argument
• the text is introduced and concludes appropriately.

40–49 (Fail). A Fail will be awarded in cases in which there is:
• limited ability to plan, organise and execute a research project or coursework assignment
• some awareness and understanding of the literature and of factual or theoretical issues, but with little development
• limited ability to analyse data
• incomplete referencing
• limited ability to present a clear and coherent argument.

20–39 (Fail). A Fail will be awarded in cases in which there is:
• very limited ability to plan, organise and execute a research project or coursework assignment
• failure to develop a coherent argument that relates to the research project or assignment
• no engagement with the relevant literature or demonstrable knowledge of the key issues
• incomplete referencing
• clear conceptual or factual errors or misunderstandings
• only fragmentary evidence of critical thought or data analysis.

0–19 (Fail). A Fail will be awarded in cases in which there is:
• no demonstrable ability to plan, organise and execute a research project or coursework assignment
• little or no knowledge or understanding related to the research project or assignment
• little or no knowledge of the relevant literature
• major errors in referencing
• no evidence of critical thought or data analysis
• incoherent argument.

The grading scheme: Examinations

The written examinations are ‘unseen’ (you will only see the paper in the exam centre) and written by hand, over a three-hour period. We advise that you practise writing exams in these conditions as part of your examination preparation, as it is not something you would normally do.

You are not allowed to take in books or notes to the exam room. This means that you need to revise thoroughly in preparation for each exam. This is especially important if you have completed the module in the early part of the year, or in a previous year.

Details of the general definitions of what is expected in order to obtain a particular grade are shown below. These guidelines take account of the fact that examination conditions are less conducive to polished work than
the conditions in which you write your assignments. Note that as the
criteria of each grade rises, it accumulates the elements of the grade
below. Assignments awarded better marks will therefore have become
comprehensive in both their depth of core skills and advanced skills.

**Postgraduate unseen written examinations marking criteria**

**80+ (Distinction).** A mark of 80+ will fulfil the following criteria:
- very significant ability to evaluate literature and theory critically
  and make informed judgements
- very high levels of creativity, originality and independence of
  thought
- outstanding levels of accuracy, technical competence, organisation,
  expression
- outstanding ability of synthesis under exam pressure.

**70–79 (Distinction).** A mark in the 70–79 range will fulfil the following criteria:
- clear evidence of wide and relevant reading and an engagement
  with the conceptual issues
- develops a sophisticated and intelligent argument
- rigorous use and a sophisticated understanding of relevant source
  materials, balancing appropriately between factual detail and key
  theoretical issues
- direct evaluation of materials and their assumptions and arguments
  challenged and/or appraised;
- original thinking and a willingness to take risks
- significant ability of synthesis under exam pressure.

**60–69 (Merit).** A mark in the 60–69 range will fulfil the following criteria:
- strong evidence of critical insight and critical thinking
- a detailed understanding of the major factual and/or theoretical
  issues and directly engages with the relevant literature on the topic
- develops a focussed and clear argument and articulates clearly and
  convincingly a sustained train of logical thought
- clear evidence of planning and appropriate choice of sources and
  methodology, and ability of synthesis under exam pressure.

**50–59 (Pass).** A mark in the 50–59 range will fulfil the following criteria:
- a reasonable understanding of the major factual and/or theoretical
  issues involved
- evidence of planning and selection from appropriate sources
- some demonstrable knowledge of the literature
- the text shows, in places, examples of a clear train of thought or
  argument
- the text is introduced and concludes appropriately.

**40–49 (Fail).** A Fail will be awarded in cases in which:
- there is some awareness and understanding of the factual or
  theoretical issues, but with little development
- misunderstandings are evident
there is some evidence of planning, although irrelevant/unrelated material or arguments are included.

20–39 (Fail). A Fail will be awarded in cases which:
- fail to answer the question or to develop an argument that relates to the question set
- do not engage with the relevant literature or demonstrate a knowledge of the key issues
- contain clear conceptual or factual errors or misunderstandings.

0–19 (Fail). A Fail will be awarded in cases which:
- show no knowledge or understanding related to the question set
- show no evidence of critical thought or analysis
- contain short answers and incoherent argument.

[2015–16: Learning & Teaching Quality Committee]

Specimen exam papers

CeFiMS does not provide past papers or model answers to papers. Modules are continuously updated, and past papers will not be a reliable guide to current and future examinations. The specimen exam paper is designed to be relevant and to reflect the exam that will be set on this module.

Your final examination will have the same structure and style and the range of question will be comparable to those in the Specimen Exam. The number of questions will be the same, but the wording and the requirements of each question will be different.

Good luck on your final examination.

Further information

Online you will find documentation and information on each year’s examination registration and administration process. If you still have questions, both academics and administrators are available to answer queries.

The Regulations are also available at www.cefims.ac.uk/regulations/, setting out the rules by which exams are governed.
Financial Engineering

Specimen Examination

This is a specimen examination paper designed to show you the type of examination you will have at the end of this module. The number of questions and the structure of the examination will be the same, but the wording and requirements of each question will be different.

The examination must be completed in THREE hours.

Answer any THREE questions.

The examiners give equal weight to each question; therefore, you are advised to distribute your time approximately equally between three questions.

Statistical tables are provided at the end of this examination paper.

Candidates may use their own electronic calculators in this examination provided they cannot store text. The make and type of calculator MUST BE STATED CLEARLY on the front of the answer book.

PLEASE TURN OVER
**Answer any THREE questions. Answer ALL parts of multi-part questions.**

1. **Answer BOTH parts of this question.**
   
a) Describe in detail what is meant by a futures contract. Explain the relationship between futures price and spot price, and give reasons to justify the requirement that margin accounts are held.

   b) Explain what position can be regarded as equivalent to a long forward contract to buy an asset at a price \( K \) on a given future date and a short position in a call option with a strike price \( K \) on the same date.

2. Explain the upper and lower bounds that must be satisfied by option prices. Illustrate the put-call parity formula and discuss its applications.

3. **Answer ALL parts of this question.**

   Suppose that a stock price \( S \) follows a geometric Brownian motion:
   
   \[
   dS = \mu S dt + \sigma S dz
   \]

   where \( dz \) is a standard Wiener increment and where \( \mu \) and \( \sigma \) are constant parameters.

   a) Provide a motivation for the above stochastic process for \( dS \).

   b) Using Itô’s Lemma, find the distribution for \( x \) in the following cases:
      
      i) \( x = \alpha S \), where \( \alpha \) is a constant;
      
      ii) \( x = S^\gamma \), where \( \gamma \) is a constant;
      
      iii) \( x = e^{\beta S} \), where \( \beta \) is a constant.

4. Define the delta, theta, and gamma of an option portfolio. Explain under what conditions theta can be regarded as a proxy for gamma in a portfolio.
5. Answer BOTH parts of this question.
   
a) Explain what is meant by a ‘volatility smile’.

   b) What information does the volatility smile provide concerning the probability distribution of asset prices used by market participants?

6. What is meant by the Gaussian copula model for time of default? Carefully explain this model and discuss the assumptions upon which it is based.

7. Explain in detail two alternatives to the Black–Scholes–Merton model. Discuss under what conditions they can be appropriate for the modelling of asset prices.

8. Explain what is meant by barrier, binary and lookback options. Describe their properties and discuss under what conditions they can be used for the hedging of risks and for speculation. How do these options compare with the corresponding regular options?

PLEASE TURN OVER
## Normal Curves Area

Standard normal probability in right-hand tail

<table>
<thead>
<tr>
<th>$z$</th>
<th>.00</th>
<th>.01</th>
<th>.02</th>
<th>.03</th>
<th>.04</th>
<th>.05</th>
<th>.06</th>
<th>.07</th>
<th>.08</th>
<th>.09</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>.5000</td>
<td>.4960</td>
<td>.4920</td>
<td>.4880</td>
<td>.4840</td>
<td>.4801</td>
<td>.4761</td>
<td>.4721</td>
<td>.4681</td>
<td>.4641</td>
</tr>
<tr>
<td>0.1</td>
<td>.4602</td>
<td>.4562</td>
<td>.4522</td>
<td>.4483</td>
<td>.4443</td>
<td>.4404</td>
<td>.4364</td>
<td>.4325</td>
<td>.4286</td>
<td>.4247</td>
</tr>
<tr>
<td>0.2</td>
<td>.4207</td>
<td>.4168</td>
<td>.4129</td>
<td>.4090</td>
<td>.4052</td>
<td>.4013</td>
<td>.3974</td>
<td>.3936</td>
<td>.3897</td>
<td>.3859</td>
</tr>
<tr>
<td>0.3</td>
<td>.3821</td>
<td>.3783</td>
<td>.3745</td>
<td>.3707</td>
<td>.3669</td>
<td>.3632</td>
<td>.3594</td>
<td>.3557</td>
<td>.3520</td>
<td>.3483</td>
</tr>
<tr>
<td>0.4</td>
<td>.3446</td>
<td>.3409</td>
<td>.3372</td>
<td>.3336</td>
<td>.3300</td>
<td>.3264</td>
<td>.3228</td>
<td>.3192</td>
<td>.3156</td>
<td>.3121</td>
</tr>
<tr>
<td>0.5</td>
<td>.3085</td>
<td>.3050</td>
<td>.3015</td>
<td>.2981</td>
<td>.2946</td>
<td>.2912</td>
<td>.2877</td>
<td>.2843</td>
<td>.2810</td>
<td>.2776</td>
</tr>
<tr>
<td>0.6</td>
<td>.2743</td>
<td>.2709</td>
<td>.2676</td>
<td>.2643</td>
<td>.2611</td>
<td>.2578</td>
<td>.2546</td>
<td>.2514</td>
<td>.2483</td>
<td>.2451</td>
</tr>
<tr>
<td>0.7</td>
<td>.2420</td>
<td>.2389</td>
<td>.2358</td>
<td>.2327</td>
<td>.2296</td>
<td>.2266</td>
<td>.2236</td>
<td>.2206</td>
<td>.2177</td>
<td>.2148</td>
</tr>
<tr>
<td>0.9</td>
<td>.1841</td>
<td>.1814</td>
<td>.1788</td>
<td>.1762</td>
<td>.1736</td>
<td>.1711</td>
<td>.1685</td>
<td>.1660</td>
<td>.1635</td>
<td>.1611</td>
</tr>
<tr>
<td>1.0</td>
<td>.1587</td>
<td>.1562</td>
<td>.1539</td>
<td>.1515</td>
<td>.1492</td>
<td>.1469</td>
<td>.1446</td>
<td>.1423</td>
<td>.1401</td>
<td>.1379</td>
</tr>
<tr>
<td>1.1</td>
<td>.1357</td>
<td>.1335</td>
<td>.1314</td>
<td>.1292</td>
<td>.1271</td>
<td>.1251</td>
<td>.1230</td>
<td>.1210</td>
<td>.1190</td>
<td>.1170</td>
</tr>
<tr>
<td>1.2</td>
<td>.1151</td>
<td>.1131</td>
<td>.1112</td>
<td>.1093</td>
<td>.1075</td>
<td>.1056</td>
<td>.1038</td>
<td>.1020</td>
<td>.1003</td>
<td>.0985</td>
</tr>
<tr>
<td>1.3</td>
<td>.0968</td>
<td>.0951</td>
<td>.0934</td>
<td>.0918</td>
<td>.0901</td>
<td>.0885</td>
<td>.0869</td>
<td>.0853</td>
<td>.0838</td>
<td>.0823</td>
</tr>
<tr>
<td>1.4</td>
<td>.0808</td>
<td>.0793</td>
<td>.0778</td>
<td>.0764</td>
<td>.0749</td>
<td>.0735</td>
<td>.0721</td>
<td>.0708</td>
<td>.0694</td>
<td>.0681</td>
</tr>
<tr>
<td>1.5</td>
<td>.0668</td>
<td>.0655</td>
<td>.0643</td>
<td>.0630</td>
<td>.0618</td>
<td>.0606</td>
<td>.0594</td>
<td>.0582</td>
<td>.0571</td>
<td>.0559</td>
</tr>
<tr>
<td>1.6</td>
<td>.0548</td>
<td>.0537</td>
<td>.0526</td>
<td>.0516</td>
<td>.0505</td>
<td>.0495</td>
<td>.0485</td>
<td>.0475</td>
<td>.0465</td>
<td>.0455</td>
</tr>
<tr>
<td>1.7</td>
<td>.0446</td>
<td>.0436</td>
<td>.0427</td>
<td>.0418</td>
<td>.0409</td>
<td>.0401</td>
<td>.0392</td>
<td>.0384</td>
<td>.0375</td>
<td>.0367</td>
</tr>
<tr>
<td>1.8</td>
<td>.0359</td>
<td>.0351</td>
<td>.0344</td>
<td>.0336</td>
<td>.0329</td>
<td>.0322</td>
<td>.0314</td>
<td>.0307</td>
<td>.0301</td>
<td>.0294</td>
</tr>
<tr>
<td>1.9</td>
<td>.0287</td>
<td>.0281</td>
<td>.0274</td>
<td>.0268</td>
<td>.0262</td>
<td>.0256</td>
<td>.0250</td>
<td>.0244</td>
<td>.0239</td>
<td>.0233</td>
</tr>
<tr>
<td>2.0</td>
<td>.0228</td>
<td>.0222</td>
<td>.0217</td>
<td>.0212</td>
<td>.0207</td>
<td>.0202</td>
<td>.0197</td>
<td>.0192</td>
<td>.0188</td>
<td>.0183</td>
</tr>
<tr>
<td>2.1</td>
<td>.0179</td>
<td>.0174</td>
<td>.0170</td>
<td>.0166</td>
<td>.0162</td>
<td>.0158</td>
<td>.0154</td>
<td>.0150</td>
<td>.0146</td>
<td>.0143</td>
</tr>
<tr>
<td>2.2</td>
<td>.0139</td>
<td>.0136</td>
<td>.0132</td>
<td>.0129</td>
<td>.0125</td>
<td>.0122</td>
<td>.0119</td>
<td>.0116</td>
<td>.0113</td>
<td>.0110</td>
</tr>
<tr>
<td>2.3</td>
<td>.0107</td>
<td>.0104</td>
<td>.0102</td>
<td>.0099</td>
<td>.0096</td>
<td>.0094</td>
<td>.0091</td>
<td>.0089</td>
<td>.0087</td>
<td>.0084</td>
</tr>
<tr>
<td>2.4</td>
<td>.0082</td>
<td>.0080</td>
<td>.0078</td>
<td>.0075</td>
<td>.0073</td>
<td>.0071</td>
<td>.0069</td>
<td>.0068</td>
<td>.0066</td>
<td>.0064</td>
</tr>
<tr>
<td>2.5</td>
<td>.0062</td>
<td>.0060</td>
<td>.0059</td>
<td>.0057</td>
<td>.0055</td>
<td>.0054</td>
<td>.0052</td>
<td>.0051</td>
<td>.0049</td>
<td>.0048</td>
</tr>
<tr>
<td>2.6</td>
<td>.0047</td>
<td>.0045</td>
<td>.0044</td>
<td>.0043</td>
<td>.0041</td>
<td>.0040</td>
<td>.0039</td>
<td>.0038</td>
<td>.0037</td>
<td>.0036</td>
</tr>
<tr>
<td>2.7</td>
<td>.0035</td>
<td>.0034</td>
<td>.0033</td>
<td>.0032</td>
<td>.0031</td>
<td>.0030</td>
<td>.0029</td>
<td>.0028</td>
<td>.0027</td>
<td>.0026</td>
</tr>
<tr>
<td>2.8</td>
<td>.0026</td>
<td>.0025</td>
<td>.0024</td>
<td>.0023</td>
<td>.0022</td>
<td>.0021</td>
<td>.0021</td>
<td>.0020</td>
<td>.0020</td>
<td>.0019</td>
</tr>
<tr>
<td>2.9</td>
<td>.0019</td>
<td>.0018</td>
<td>.0018</td>
<td>.0017</td>
<td>.0016</td>
<td>.0015</td>
<td>.0015</td>
<td>.0014</td>
<td>.0014</td>
<td>.0014</td>
</tr>
</tbody>
</table>

[END OF EXAMINATION]
Financial Engineering
Unit 1  Derivatives Contracts

Contents

Unit Overview 2
1.1 Introduction 3
1.2 Forward Contracts 3
1.3 Futures Contracts 4
1.4 Options 5
1.5 Types of Traders 6
1.6 A ‘Health Warning’ 7
1.7 Application: Data tables 8
1.8 Conclusion 11
1.9 Solutions to Exercises 12
Unit Overview

Unit 1 will introduce some fundamental terminology relating to derivatives, and will describe some basic features of derivatives contracts. You will examine the characteristics of forward contracts, futures contracts and options, and you will learn about the types of traders who deal in derivatives, and some of the dangers of their misuse. You will also use data tables to construct profit patterns for options.

Learning outcomes

When you have completed your study of this unit and its readings, you will be able to:

- discuss and differentiate between the most common types of financial derivatives: forward contracts, futures and options
- explain the advantages of long and short positions in these contracts
- distinguish between put and call options
- outline three main reasons for the use of derivatives
- discuss the potential dangers in misusing derivatives, and how to avoid them
- conduct sensitivity analysis using data tables.

📖 Reading for Unit 1

Textbook


1.1 Introduction

Derivatives are a general class of financial contracts, which are written in terms of an underlying financial or real asset. Their payoff over a given period of time will depend on the performance of the underlying asset, which could include stocks, interest rates or exchange rates. The value of a financial derivative, therefore, depends on the performance of the underlying asset. Financial derivatives include futures and options. They are a flexible form of financial instrument, and can be very effective in enabling investors to achieve a complex risk profile. In particular, derivatives can be a very powerful instrument for reducing risk, or hedging. However, derivatives can also be used to increase the risk of investors, if they are used for speculation. Finally, derivatives allow investors to make riskless profits by exploiting mispricing of assets when they are used for arbitrage.

The application section in this unit provides an introduction to data tables. Data tables are used widely in financial modelling for sensitivity analysis. In this section you will construct the profit pattern for a call option on a stock. In later units you will study how to use data tables to analyse more sophisticated strategies.

We begin by looking at types of derivative contracts.

1.2 Forward Contracts

The simplest derivative instrument is a forward contract. This is ‘an agreement to buy or sell an asset at a certain future time for a certain price’ (Hull, 2018:28). You can see that the main feature of forward contracts is that it enables you to fix now the price at which a transaction will take place at a future date. You can therefore make use of a forward contract in order to eliminate the uncertainty associated with the future price of an asset. A forward contract can be contrasted to a spot contract, where delivery of the asset is immediate. Thus, a forward contract can effectively eliminate the uncertainty of the future spot price.

The reduction of uncertainty could be desirable from the point of view of risk management. However, it is important you realise that the elimination of uncertainty does not imply that you would always be better off by entering a forward contract. Indeed, if you successfully hedge your position you will be able to eliminate or reduce the losses associated with adverse movements in the price of the underlying asset, but at the cost of foregoing the profits associated with potentially favourable asset price changes.

In order to see this point, denote the delivery price written in the forward contract by $K$ and the future spot price on the delivery date by $S_T$. If you have a long position in the forward contract – that is, if you commit yourself to purchasing the underlying asset at contract maturity – your payoff upon maturity will be

$$S_T - K$$ (1.1)
The value $K$ is written into the contract, but $S_T$ is the spot price that will prevail in the market at the future delivery date, and cannot be known in advance. If $S_T$ turns out to be greater than $K$, you will be able to purchase at a price $K$ an asset that has the greater market price $S_T$, and will therefore make a profit: $S_T - K > 0$. However, if the market price $S_T$ happens to be less than $K$, you will have to pay the price $K$ for an asset whose market price is only $S_T$, and will therefore make a loss: $S_T - K < 0$.

If you commit yourself to selling an asset, you will have a short position in the forward contract. In this case, your payoff at maturity will be given by:

$$K - S_T$$  \hspace{1cm} (1.2)

Your profits and losses will now be the mirror image to those in a long position. You will make a gain if the market price $S_T$ is less than the forward price $K$, and will make a loss if $S_T$ is greater than $K$ on maturity.

If you have a long position in an asset, the gains or losses from a long position in a forward contract written on that asset will offset the losses or gains from your position in the underlying asset. You will therefore be able to use forward contracts in order to achieve a hedged position, so that your payoff is no longer subject to the asset price uncertainty.

---

**Reading**

Please now stop and read the introduction to Chapter 1 to the end of the section on forward contracts of your textbook by Hull, on pages 23–30. Pay special attention to the numerical examples that motivate the use of forward contracts.

---

**Exercise 1.1**

Please now solve problem 1.5 on page 41 of your textbook. An answer is provided at the end of this unit.

---

### 1.3 Futures Contracts

The forward contracts that you studied in section 1.2 are usually arranged over-the-counter (OTC) by two financial institutions, or by a financial institution and one of its clients (see the discussion in section 1.2 on pages 25–26 of your textbook by Hull). This implies that the characteristics of the contract can be customised to the specific needs of the two parties. However, over-the-counter contracts present the potential disadvantage of involving some credit risk (that is, the risk that the counterparty may default on its obligations), and could also suffer from limited liquidity. For these reasons, clearing houses are increasingly required for some OTC transactions.

By contrast, futures contracts have similar features to forward contracts, but are normally traded on an exchange market. This requires that futures contracts be standardised – that is, they must specify in detail the characteristics of the particular underlying asset, and must follow standard conventions regarding the contract size, the delivery arrangements and the delivery
dates. This both significantly reduces the credit risk associated with futures contracts and makes them much more liquid.

Futures contracts are traded on markets such as the CME Group (created in 2007 from the merger between the Chicago Board of Trade (CBOT) and the Chicago Mercantile Exchange (CME)), where trade instructions are carried out by brokers. As a **bona fide** insurance against the risk of default, brokers usually require that the investor deposits a fund known as the *initial margin*. The initial margin can be modified over the life of the contract, depending on the changes in the market value of the futures contract (*variation margin*). In turn, brokers must maintain margins with a **clearing house**, which acts as an intermediary in futures transactions. These are the *clearing margins*. The main role of margins is to reduce the credit risk in futures contracts.

**Reading**

Please now read section 1.4 on page 30 and Chapter 2, pages 46–66 of your textbook by Hull. Section 1.4 provides a brief introduction to futures contracts, whereas Chapter 2 describes the mechanics of futures margins, including a detailed discussion of the workings of margins. Table 2.3 on page 65 usefully summarises the main differences between forward and futures contracts.

**Exercise 1.2**

Please solve problem 1.6 on page 41 of the textbook by Hull.

### 1.4 Options

Forward and futures contracts constitute a binding commitment for investors. If an investor has a long position in a forward contract, for instance, she is committing herself to completing the contract at maturity and to purchasing the underlying asset. Forward and futures contracts therefore require final delivery, unless they are closed out prior to maturity (which is typically the case for futures contracts). By contrast, **options contracts** confer onto their holders the right to buy or sell an asset at or before maturity, but do not prescribe that the purchase or sale must be executed. In other words, there is no obligation involved to carry out the transaction. If it is not profitable to do so, the holder of an option contract could choose to let the contract expire unexercised. Their only loss would be the initial cost of the option contract.

An option to buy an asset is a *call option*, and an option to sell an asset is a *put option*. The price at which the purchase or the sale can be carried out is called the *strike price*, or the *exercise price*. The price of the option contract is called the *option premium*. Option contracts that can be exercised any time up to and including the expiration date are called *American options*, whereas contracts that can only be exercised on the expiration date are called *European options*.

Investors who have the right to buy or to sell an asset (in call options or in put options, respectively) are said to have a *long* position. Their counterparties, who have issued the options, are said to have a *short* position: the options would be exercised against them.
The main feature of options contracts is that their payoffs can be strongly asymmetric. For instance, if you have a long position in a call option, the most you can lose is the premium that you paid for the option. By contrast, your gains could potentially be very large, since if the price of the asset increases on maturity you could profit from the whole difference between the spot price of the asset and the exercise price. The asymmetry in the payoff profiles of options makes them a very versatile financial instrument.

In this module you will examine in detail a number of different option contracts, and you will see how they can be combined to achieve a large variety of risk profiles for your financial portfolios.

Reading

Please now stop and read section 1.5 of your textbook by Hull, pages 30–33. Pay particular attention to the two diagrams in Figure 1.3 on page 33, which illustrate the payoff profiles associated with a long position in a call option and a short position in a put option on a stock.

Exercise 1.3

Please solve problem 1.7 on page 42 of the book by Hull.

1.5 Types of Traders

As noted already, derivatives are very flexible financial instruments. They can be used for a variety of purposes, and can be very effective in modifying the risk profile of investors.

There are three main reasons for the use of derivatives.

- First, they can be used to reduce risk – that is, for hedging. For instance, if an investor has a long position in an asset she can hedge her risk by taking a short position on a derivative written on the underlying asset.

- Second, derivatives can be used in order to increase risk – that is, for speculation. If you believe that the market is mispricing the probability that the price of an asset will change – for instance, you could believe that it is more likely that the price of an asset will fall, relative to what is expected by the market and is reflected in the asset price. In this case, you could speculate by directly taking a short position in the asset. However, an alternative strategy could involve taking a short position on a derivative written on the asset. Taking a short position on a derivative could be more profitable, because futures and options can provide a form of leverage. The financial consequences are much larger, given the size of the initial investment.

- Finally, derivatives can be used to exploit potential arbitrage opportunities, which could arise, for instance, from small discrepancies in the pricing of assets across different markets, or from inconsistency in the pricing of similar assets. Since arbitrage involves little or no risk, large amounts of resources have been devoted to developing software programmes that are able to execute automatic transactions whenever arbitrage opportunities are seen to arise.
Reading
Please now read sections 1.6 to 1.9 of the book by Hull, pages 33–39. You should study carefully the examples in Tables 1.4 and 1.5, which illustrate the potential effect of leverage when using futures and options for speculative investment.

Exercise 1.4
Please solve problem 1.9 on page 42 of the book by Hull.

Exercise 1.5
Please solve problem 1.16 on page 42 of the book by Hull.

Exercise 1.6
Please answer question 1.21 on page 42 of the book by Hull.

1.6 A ‘Health Warning’
While derivatives are very flexible instruments, if they are misused they can lead to potentially catastrophic losses. There has been a number of high-profile instances of reputable financial institutions being forced to fold because of the enormous losses suffered from speculation in the derivatives market. It is therefore essential that proper measures are put in place to monitor and control the risks associated with trading in derivatives. These measures include

- setting proper risk limits
- monitoring traders
- separating trading execution from book keeping and accounting
- being aware of the usefulness but also of the limitations of quantitative models, and
- taking liquidity risk seriously.

These measures will not completely eliminate all risks, but can go a long way towards reducing the likelihood of negative outcomes from the trading in derivatives.

Reading
Please now read section 1.10 and the Summary on pages 39–41 and Chapter 36, pages 828–39 of your textbook by Hull. Chapter 36 is towards the end of the book. You may not be able to understand yet all the references in the chapter, but it is very useful that you are aware of the potential issues in the use of derivatives, and of some of the main measures that should be taken in order to avoid the most serious adverse consequences; and you should therefore read this chapter now.
1.7 Application: Data tables

In this section you will examine one of the tools used extensively in financial modelling, data tables, and you will create a data table to show the profit patterns from purchasing a call option on a stock. First you will examine a function that can be used to make your Excel workbooks more informative.

1.7.1 FORMULATEXT and Getformula

In this module you will develop and use relatively complex formulas and spreadsheets. To help understand the spreadsheets it would be useful to see the formulas contained in particular cells in a workbook. (Excel has the facility to Show Formulas in cells *instead* of the results, available on the Formulas tab, but it would be more useful to see the results *and* the formulas at the same time.)

This can be achieved using the Excel function FORMULATEXT. This function has the syntax =FORMULATEXT(reference), where ‘reference’ is the cell whose formula you would like to display. The function displays the formula that is contained in the reference cell, while leaving the results visible in the reference cell.

FORMULATEXT is a built-in Excel function, and it is available in new workbooks and any workbooks you create. For this reason it is probably most convenient for you to use FORMULATEXT in your own workbooks. However, FORMULATEXT was introduced in Excel 2013. If you are using an earlier version of Excel you can create a user-defined formula to do the same thing, and the instructions to do this are available in your Benninga textbook, as follows.

� Study Note

In your textbook by Benninga and the associated Excel workbooks you will see a formula called ‘Getformula’. Getformula is a User-defined formula, and has the same effect as FORMULATEXT.

Advice on Getformula and the instructions to put Getformula into an Excel workbook are provided in Chapter 0 ‘Before all else’ in your Benninga textbook, sections 0.2 to 0.6, pages 2–6. The code on page 4 of your textbook is available to copy from the Excel file named ‘FM4, Chapter 00, Before you start.xlsm’, on the tab ‘Getformula into VBA’.

To use the Visual Basic Editor you will need to put the Developer tab on your ribbon. If this is not present already, go to File>Options>Customize Ribbon and make sure the Developer tab is selected.

If you follow this approach to define the function, Getformula will now be available in the saved workbook, but it will not be available in new workbooks.

The workbook ‘FM4, Chapter 00, Before you start.xlsm’ already has Getformula defined, so you could use this file as the basis for your own workbooks, if you are unable to follow these instructions successfully.

As noted above, if you are using Excel 2013 or later it is probably more convenient to use the FORMULATEXT function in your own workbooks, and be aware that Getformula in the Benninga textbook and associated Excel workbooks performs the same function.
1.7.2 Data tables

Data tables are a powerful tool for analysing financial instruments, including derivatives, and have wide application in financial modelling. They are useful for conducting sensitivity analysis, analysing how the results vary as one or other inputs change. To demonstrate how to use a data table we will recreate the profit pattern for the call option shown in Figure 1.5 in your Hull textbook. The profit pattern shows how the option profit changes for a range of prices of the underlying stock.

Intuitively, a data table works like this. For this example we need to create a formula for the profit from purchasing a call option on a stock. As you have seen in this unit, the profit will depend on:

- the premium paid to purchase the call option
- the strike price (also known as the exercise price)
- the price of the underlying stock at maturity.

You have seen that if the stock price at maturity is less than the strike price, the call option will not be exercised, the payoff will be zero, and the overall loss will be the call premium already paid. If the stock price is more than the exercise price, the option will be exercised. The payoff will be the positive difference between the stock price and the exercise price, and the overall profit will be reduced by the call premium already paid.

In Unit 2 you will examine in more detail the profits for various types of options, but based on the above reasoning we can say that the profit from a long call option is

$$\max (S_T - K, 0) - c$$

where:

- $S_T$ is the stock price at maturity, time $T$
- $K$ is the strike price
- $c$ is the premium paid for the call option.

If

$$S_T < K$$

the option would not be exercised,

$$\max (S_T - K, 0) = 0$$

and the overall loss equals $-c$.

If

$$S_T > K$$

the option will be exercised,

$$\max (S_T - K, 0) = S_T - K$$
and the overall profit is

\( (S_T - K) - c \)

The data table has two inputs. Firstly, the data table needs to reference the formula for the profit from the call option. Secondly, we need to specify a range of values for the stock price at maturity. When we have created the data table it will show the option profit for each of the values of the stock price we have specified.

We have described the intuition behind a one-dimensional data table – only one input is varying in the table, the stock price. We could extend the data table with additional formulas, to assess the impact of varying the stock price on, for example, the profit from writing a call option, purchasing a put option, and writing a put option. But the input being varied is always the stock price. Two-dimensional data tables allow you to assess the impact on one formula of varying two inputs. For example, we could assess the impact on the call option profit of various stock prices and strike prices.

Reading

Please now read from Chapter 31 ‘Data tables’ in your Benninga textbook, sections 31.1–31.5 and section 31.8, pages 823–26 and page 835. These sections explain how to set up a data table, using a relatively simple net present value example.

As noted in Benninga, data tables can take up a lot of processing power. Excel recalculates formulas in a workbook automatically when there is a change in one of the cells on which the formulas are dependent. The Excel default recalculation setting is ‘Automatic Except for Data Tables’. For the data tables to operate you will need to change the calculation option to ‘Automatic’ (Formulas>Calculation Options) or use the ‘Calculate Now’ button (also on the Formulas tab).

Review Question

The data table described in this last reading is available in the workbook ‘FM4, Chapter 31, data tables.xlsm’, in the tab ‘Pages 823-826’.

Examine what happens to the cash flows, and the data table for NPV and IRR, if you change the cash flow in year 1 from 234 to 300. Hint: If the projected cash flows in years 1 to 7 change, but NPV and IRR in the data table do not change, use the ‘Calculate Now’ button on the ‘Formulas’ tab.

Let us now return to our example and create a chart for the call option profit pattern shown in Figure 1.5 in your Hull textbook. The strike price is $22.50, the call option premium is $1, and the illustrative range of stock prices at maturity is $15–$30. The formula for the call option profit requires a particular stock price at maturity – let us choose the current stock price, $20. The example in Figure 1.5 is for 2,000 options. To demonstrate the principles of creating a data table we will consider the profit from purchasing one call option.
The profit pattern has been created in the file ‘M482 U1 Application Profit pattern long call option.xlsm’. Within this file:

- the terminal stock price is in cell B3
- the exercise price is in cell B5
- the call premium is in cell B7
- the call option profit formula, given by equation (1.3), is in cell B9.

The formula in B9 is shown using Getformula in cell C9, and FORMULATEXT in C10.

The call option profit using the values we have suggested is minus $1. The stock price of $20 is less than the strike price of $22.50, the call option is not exercised, but the call premium has been paid.

Now let us create the data table.

In the first row of the data table, the entry for the long call profit references the cell containing the formula for the call option profit, so the formula is ‘=B9’. (Note that if we wanted to consider 2,000 call options we could change this formula to ‘=2000*B9’.)

We place the range of terminal stock prices starting in the next row down, starting at $15 and going to $30, and we have chosen a step of $0.50.

To create the data table select the column of terminal stock prices and the formula referencing the call option profit formula, so cells C14:D45. Then go to Data>What-if Analysis>Data Table…

The range of terminal stock prices is arranged in a column. Leave the Row input cell blank. The column input cell is the terminal stock price in cell B3. (To conduct the What-if Analysis the data table will substitute each of the stock prices in the range for the contents of cell B3.)

If your Excel Calculation Option is set as ‘Automatic Except for Data Tables’, the call option profit for the range of terminal stock prices in the data table will be —1. Why is that? If this happens, refresh the data table using the Calculate button. You should now have a range of call option profits starting at —1 for terminal stock prices $15 to $22.50, then —$0.50 rising to $6.50.

Now you can create the chart of the call option profit profile. The input range is the column of terminal stock prices and long call profit (not including the cells C14 and D14), and the chart type is ‘Scatter with Straight Lines’.

Exercise 1.7

For the call option and the stock in Exercise 1.4 (question 1.9 on page 42 of Hull) create a data table and chart showing how the profits change for various values of the terminal stock price.

1.8 Conclusion

This unit has introduced the most common types of financial derivatives: forward contracts, futures and options. You have studied their different characteristics and have started to learn how you can use them to modify the
payoff of your investment profile. You have also constructed simple profit patterns using data tables. In the next units of this module you will build on the basic concepts and techniques presented in this unit and you will learn how you can construct very complex risk profiles by making use of derivatives instruments.

1.9 Solutions to Exercises

Here are the answers to the exercises you’ve been assigned for this unit, but please don’t check the answers until you’ve worked them out for yourself.

Exercise 1.1

a) At the end of the contract the investor sells 100,000 British pounds for US dollars at an exchange rate of 1.5000 US dollars per pound, whereas the spot exchange rate on maturity is 1.4900. The investor therefore gains $1,000.

b) At the end of the contract the investor sells 100,000 British pounds for US dollars at an exchange rate of 1.5000 US dollars per pound, when the spot exchange rate on maturity is 1.5200. The investor therefore loses $2,000.

Exercise 1.2

a) The trader commits herself to selling 50,000 pounds of cotton at the end of the contract at a price of 50 cents per pound. If the spot price of cotton at maturity is only 48.20 cents per pound, she will gain $900.

b) The trader must sell 50,000 pounds of cotton at the end of the contract at a price of 50 cents per pound, when the spot price of cotton at maturity is 51.30 cents per pound. She will therefore lose $650.

Exercise 1.3

You have sold a put option, and therefore you have a short position on a put contract. You have received the option premium, and have committed yourself to buying 100 shares at a price of $40, if the party who has purchased the put option decides to exercise her right to sell the shares at the exercise price. At present, it would not be profitable to exercise the option because the market price of each share is $41.

The investor who has purchased the put option will only find it profitable to exercise it if the stock price falls below $40. For instance, if the stock price falls to $30, the holder of the put option could purchase the shares at $30 and sell them to you at $40. She will have made a profit of $1,000, minus the price of purchasing the option contract. You will have to buy the shares at $40, although their market price is only $30. You will therefore have made a loss of $1,000, minus the premium that you have received from the option holder.
Exercise 1.4

One strategy that you can implement is to purchase 200 shares ($5,800/29); the alternative strategy would be to purchase 2,000 call options ($5,800/2.9). The table below illustrates the payoffs associated with each one of the two strategies when the stock price increases to $40 and when it declines to $25.

When the stock price increases to $40, your profit from the first strategy will be $200 \times ($40 - $29) = $2,200, and [2,000 \times ($40 - $30)] - $5,800 = $14,200 from the second strategy, if you exercise your call option and purchase stocks at the strike price of $30. By contrast, when the stock price falls to $25 your losses will be $200 \times ($29 - $25) = $800 from the first strategy, but will amount to your whole investment of $5,800 because you will have to let your options expire unexercised.

<table>
<thead>
<tr>
<th>Strategy</th>
<th>Stock price $25</th>
<th>Stock price $40</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buy 200 shares</td>
<td>($800)</td>
<td>$2,200</td>
</tr>
<tr>
<td>Buy 2,000 call options</td>
<td>($5,800)</td>
<td>$14,200</td>
</tr>
</tbody>
</table>

You can verify that the second strategy yields larger gains when the stock price increases, but also larger losses when the stock price falls.

Exercise 1.5

The put option will be exercised against the trader if the stock price is less than $30 in December. If we consider the price that the trader has received for issuing the option, she will make a profit provided the stock price in December is greater than $26 (ignoring the time value of money).

Exercise 1.6

With futures and options, the gain to one party must always be equal to the losses suffered by the other party. Hence, if we add up the payoffs to both parties, they must always add up to zero. Graphically, the payoff from a short position is the mirror image of the payoff from a long position (that is, it is symmetrical about the horizontal axis).

Exercise 1.7

The initial share price is $29. A call option with strike price $30 costs $2.90. With $5,800 available to invest, it is possible to purchase 2,000 call options or 200 shares.

The formula for the profit from the call option is given by equation (1.3)

$$\max (S_T - K, 0) - c$$

and the formula for the profit from investing in shares is

$$S_T - S_0$$

where:

$S_0$ is the initial stock price.
The data table and chart showing the profit from two strategies, investing in the stock or the call option, for a range of stock prices at maturity of $25 to $40, is included in the file ‘M482 Exercise 1.7 Profit pattern stock or long call.xlsm’. The chart is also shown in Figure 1.1.

**Figure 1.1  Profits from purchasing shares or call options**

![Chart showing profits from purchasing shares or call options](image-url)